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This document provides instructions for integrating the phone system with Cisco Unity.

Integration Tasks
Before doing the following tasks to integrate Cisco Unity with the Cisco CallManager phone system, 
confirm that the Cisco Unity server is ready for the integration by completing the applicable tasks in the 
Cisco Unity Installation Guide.

The following task lists describe the process for creating, changing, and deleting integrations.

Task List to Create the Integration
Use the following task list to set up a new integration with the Cisco CallManager phone system. If you 
are installing a new Cisco Unity server by using the Cisco Unity Installation Guide, you may have 
already completed some of the following tasks.

1. Review the system and equipment requirements to confirm that all phone system and Cisco Unity 
server requirements have been met. See the “Requirements” section on page 2.

2. Plan how the voice messaging ports will be used by Cisco Unity. See the “Planning How the Voice 
Messaging Ports Will Be Used by Cisco Unity” section on page 5.

3. Program Cisco CallManager. See the “Programming the Cisco CallManager Phone System” section 
on page 7.

• When configuring voice mail ports for a Cisco Unity server without failover or the primary 
server with failover, do all the procedures in this section.

• When configuring voice mail ports for a secondary server with failover, do only the “To Add 
Voice Mail Ports to Cisco CallManager” procedure.

4. Set up the gateways that service Cisco Unity. See the “Setting Up the Gateways That Service 
Cisco Unity” section on page 17.
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5. Create the integration. See the “Creating a New Integration with the Cisco CallManager Phone 
System” section on page 17.

6. Test the integration. See the “Testing the Integration” section on page 23.

7. If you have a secondary server for Cisco Unity failover, integrate the secondary server. See the 
“Integrating a Secondary Server for Cisco Unity Failover” section on page 27.

Task List to Make Changes to an Integration
Use the following task list to make changes to an integration after it has been created.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Changing the Settings for 
an Existing Integration” section on page 30.

2. Make the changes you want to the existing integration. See the “Changing the Settings for an 
Existing Integration” section on page 30.

Task List to Change the Number of Voice Messaging Ports
Use the following task list to change the number of voice messaging ports for an integration after it has 
been created.

1. Change the number of voice messaging ports. See the “Changing the Number of Voice Messaging 
Ports” section on page 30.

2. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Changing the Settings for 
an Existing Integration” section on page 30.

3. Make the changes you want to the existing integration. See the “Changing the Settings for an 
Existing Integration” section on page 30.

Task List to Delete an Existing Integration
Use the following task list to remove an existing integration.

1. Start the Cisco Unity Telephony Integration Manager (UTIM). See the “Deleting an Existing 
Integration” section on page 31.

2. Delete the existing integration. See the “Deleting an Existing Integration” section on page 31.

Requirements
The Cisco CallManager integration supports configurations of the following components:

Phone System

• A Cisco IP telephony applications server consisting of Cisco CallManager 3.2(1) or later, running 
on a Cisco Media Convergence Server (MCS) or customer-provided server meeting approved Cisco 
configuration standards.

• Cisco licenses for all phone lines, IP phones, and other H.323-compliant devices or software (such 
as Cisco VirtualPhone and Microsoft NetMeeting clients) that will be connected to the network, as 
well as one license for each Cisco Unity port.
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• IP phones for the Cisco CallManager extensions.

• A LAN connection in each location where you will plug an IP phone into the network.

• For multiple Cisco CallManager clusters, subscribers can dial an extension on another 
Cisco CallManager cluster without having to dial a trunk access code or prefix.

Cisco Unity Server

• Cisco Unity version 4.0(1) or later, installed and ready for the integration as described in the 
Cisco Unity Installation Guide.

• A license that enables the applicable number of voice messaging ports.

Integration Description
The Cisco CallManager integration uses the LAN to connect Cisco Unity and the phone system. The 
gateway provides connections to the PSTN. Figure 1 shows the connections.

Figure 1 Connections Between the Phone System and Cisco Unity

Call Information
The phone system sends the following information with forwarded calls:

• The extension of the called party

• The extension of the calling party (for internal calls) or the phone number of the calling party (if it 
is an external call and the system uses caller ID)

• The reason for the forward (the extension is busy, does not answer, or is set to forward all calls)

Cisco Unity uses this information to answer the call appropriately. For example, a call forwarded to 
Cisco Unity is answered with the personal greeting of the subscriber. If the phone system routes the call 
to Cisco Unity without this information, Cisco Unity answers with the opening greeting.
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Integration Features
The Cisco CallManager integration with Cisco Unity provides the following features.

When a Cisco Survivable Remote Site Telephony (SRST) router is part of the network and the Cisco 
SRST router takes over call processing functions (for example, because the WAN link is down), the 
Cisco SRST integration with Cisco Unity has the following feature limitations:

• Call forward to busy greeting—When the Cisco SRST router uses FXO/FXS connections to the 
PSTN and a call is forwarded from a branch office to Cisco Unity, the busy greeting cannot play.

• Call forward to internal greeting—When the Cisco SRST router uses FXO/FXS connections to 
the PSTN and a call is forwarded from a branch office to Cisco Unity, the internal greeting cannot 
play. Because the PSTN provides the calling number of the FXO line, the caller is not identified as 
a subscriber.

• Call transfers—Because an access code is needed to reach the PSTN, call transfers from 
Cisco Unity to a branch office will fail.

• Identified subscriber messaging—When the Cisco SRST router uses FXO/FXS connections to the 
PSTN and a subscriber at a branch office leaves a message or forwards a call, the subscriber is not 
identified. The caller appears as an unidentified caller.

• Message waiting indication—MWIs are not updated on branch office phones. So MWIs will not 
correctly reflect when new messages arrive or when all messages have been listened to. We 
recommend resynchronizing MWIs after the WAN link is reestablished.

• Message notification—Because an access code is needed to reach the PSTN, message notifications 
from Cisco Unity to a branch office will fail.

• Routing rules—When the Cisco SRST router uses FXO/FXS connections to the PSTN and a call 
arrives from a branch office to Cisco Unity (either a direct or forwarded call), routing rules will fail.

Call forward to personal greeting When an incoming call is routed to an unanswered extension, the 
call is forwarded to the voice mail of the subscriber. The caller then 
hears the personal greeting of the subscriber and can leave a 
message.

Call forward to busy greeting When an incoming call is routed to a busy extension, the call is 
forwarded to the voice mail of the subscriber. The caller then hears 
the busy greeting (if the subscriber enabled it) and can leave a 
message.

Caller ID Cisco Unity receives caller ID information from the phone system 
(if available). This information appears in the subject line of the 
message in the desktop messaging application.

Easy message access A subscriber can retrieve messages without entering an ID. 
Cisco Unity identifies a subscriber based on the extension from 
which the call originated. A password may be required.

Identified subscriber messaging Cisco Unity automatically identifies a subscriber who leaves a 
message during a forwarded internal call, based on the extension 
from which the call originated.

Message waiting indication When a message is waiting for a subscriber, Cisco Unity notifies 
Cisco CallManager to activate the message waiting indicator (MWI) 
on the subscriber extension.
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When the Cisco SRST router uses PRI/BRI connections, the caller ID for calls from a branch office to 
Cisco Unity may be the full number (exchange plus extension) provided by the PSTN and therefore may 
not match the extension of the Cisco Unity subscriber. If this is the case, you can let Cisco Unity 
recognize the caller ID by using alternate extensions (for instructions, see the “Appendix: Using 
Alternate Extensions and MWIs” section) or by using extension remapping (for instructions, refer to the 
“Remapping Extension Numbers” section of the “System Settings” chapter in the applicable Cisco Unity 
System Administration Guide (release 4.0(3) or later), available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/products_administration_guides_list.html.

For information on setting up Cisco SRST routers, refer to the “Integrating Voice Mail with Cisco SRST” 
section of the “Cisco SRST System Administrator Guide,” available at 
http://www.cisco.com/univercd/cc/td/doc/product/software/ios122/122newft/122limit/122z/122zj15/in
dex.htm.

Integrations with Two Phone Systems
Cisco Unity can be integrated with two phone systems at one time. For information on and instructions 
for integrating Cisco Unity with two phone systems, see the Dual Phone System Integration Guide, 
available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/integuid/multi/itmultin.htm.

Having two integrations requires that an adequate number of voice messaging ports on the Cisco Unity 
server are connected to the phone systems. This number of ports must not exceed the maximum number 
of ports that are enabled by the Cisco Unity license files.

Planning How the Voice Messaging Ports Will Be Used by 
Cisco Unity

Before programming the phone system, you need to plan how the voice messaging ports will be used by 
Cisco Unity. The following considerations will affect the programming for the phone system (for 
example, setting up the hunt group or call forwarding for the voice messaging ports):

• The number of voice messaging ports installed.

• The number of voice messaging ports that will answer calls.

• The number of voice messaging ports that will only dial out, for example, to send message 
notification, to set message waiting indicators (MWIs), to make AMIS deliveries, and to make 
telephone record and playback (TRAP) connections.

• The number of voice messaging ports that will be dedicated to set MWIs if Cisco Unity is connected 
to multiple clusters of Cisco CallManager and if the Cisco CallManager server has dedicated MWI 
voice messaging ports.

Table 1 describes the voice messaging port settings in Cisco Unity that can be set in UTIM and are 
displayed as read-only text on the System > Ports page of the Cisco Unity Administrator.
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The Number of Voice Messaging Ports to Install

The number of voice messaging ports to install depends on numerous factors, including:

• The number of calls Cisco Unity will answer when call traffic is at its peak.

• The expected length of each message that callers will record and that subscribers will listen to.

• The number of subscribers.

• The number of ports that will be set to dial out only.

• The number of calls made for message notification.

• The number of MWIs that will be activated when call traffic is at its peak.

• The number of AMIS delivery calls.

Table 1 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a 
ringing tone but are not answered. Typically, the port is disabled only by the installer during 
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming 
calls from unidentified callers or from subscribers. As a general guideline, set Answer Calls 
on approximately 75 percent of the ports.

Message Notification Check this check box to designate the port for notifying subscribers of messages. Assign 
Message Notification to the least busy ports, which typically are those with the highest port 
numbers for the phone system. As a general guideline, set Message Notification, Dialout 
MWI, and TRAP Connection on approximately 25 percent of the ports.

Dialout MWI

(not used by serial or SMDI 
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI 
to the least busy ports, which typically are those with the highest port numbers for the phone 
system. As a general guideline, set Message Notification, Dialout MWI, and TRAP 
Connection on approximately 25 percent of the ports.

AMIS Delivery

(available with the AMIS 
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice 
messages from Cisco Unity subscribers to users on another voice messaging system. 
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol, 
which provides an analog mechanism for transferring voice messages between different 
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long 
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule 
page so that outgoing AMIS calls are placed during closed hours or at times when 
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback 
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the 
least busy ports, which typically are those with the highest port numbers for the phone 
system. As a general guideline, set Message Notification, Dialout MWI, and TRAP 
Connection on approximately 25 percent of the ports.
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• The number of TRAP connections needed when call traffic is at its peak. (TRAP connections are 
used by Cisco Unity web applications and e-mail clients to play back and record over the phone.)

It is best to install only the number of voice messaging ports that are needed so that system resources are 
not allocated to unused ports.

The Number of Voice Messaging Ports That Will Answer Calls

The calls that the voice messaging ports answer can be incoming calls from unidentified callers or from 
subscribers. Typically, these voice messaging ports are the busiest. They also have the lowest port 
numbers for the phone system.

You can set voice messaging ports to both answer calls and to dial out (for example, to send message 
notifications).

The Number of Voice Messaging Ports That Will Only Dial Out, and Not Answer Calls

Ports that will only dial out and will not answer calls can do one or more of the following:

• Notify subscribers by phone, pager, or e-mail of messages that have arrived.

• Turn MWIs on and off for subscriber extensions.

• Make outbound AMIS calls to deliver voice messages from Cisco Unity subscribers to users on 
another voice messaging system. (This action is available only with the AMIS licensed feature.)

• Make a TRAP connection so that subscribers can use the phone as a recording and playback device 
in Cisco Unity web applications and e-mail clients.

Typically, these voice messaging ports are the least busy ports. They also have the highest port numbers 
for the phone system.

Caution In programming the phone system, do not send calls to voice messaging ports in Cisco Unity that cannot 
answer calls (voice messaging ports that are not set to Answer Calls). For example, if a voice messaging 
port is set only to Dialout MWI, do not send calls to it.

The Number of Voice Messaging Ports That Will Be Dedicated to Activating MWIs on Other Cisco CallManager 
Clusters

If Cisco Unity services multiple clusters of Cisco CallManager, there must be at least one voice 
messaging port per cluster dedicated for turning MWIs on and off for each cluster. For example, if the 
system has four clusters, at least four ports on Cisco Unity must be dedicated to activating MWIs, one 
port for each cluster.

Preparing for Programming the Phone System

Record your decisions about the voice messaging ports to guide you in programming the phone system.

Programming the Cisco CallManager Phone System
After Cisco CallManager software is installed, do the procedures in this section to program Cisco 
CallManager to work with Cisco Unity:

• When configuring voice mail ports for a Cisco Unity server without failover, or the primary server 
with failover, do all the procedures in this section.
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• When configuring voice mail ports for a secondary server with failover, do only the “To Add Voice 
Mail Ports to Cisco CallManager” procedure.

To Add Partitions and a Calling Search Space to Contain the Voice Mail Ports

Step 1 In the Cisco CallManager Administration, click Route Plan > Partition.

Step 2 Click Add a New Partition.

Step 3 Enter the name and description you want for the partition that will contain all voice mail port directory 
numbers except for the first voice mail port, which will be assigned the voice mail pilot number. For 
example, enter “VMRestrictedPT, Partition for voice mail port directory numbers.” For a diagram of the 
configuration, see Figure 2. For a diagram of the configuration with Cisco Unity failover, see Figure 3.

Step 4 Click Insert.

Step 5 Click Add a New Partition.

Step 6 Enter the name and description you want for the partition that will contain the directory number of the 
first voice mail port, which will be assigned the voice mail pilot number. For example, enter 
“VMPilotNumberPT, Partition for the voice mail pilot number.” For a diagram of the configuration, see 
Figure 2. For a diagram of the configuration with Cisco Unity failover, see Figure 3.

Step 7 Click Insert.

Step 8 Click Route Plan > Calling Search Space.

Step 9 Click Add a New Calling Search Space.

Step 10 In the Calling Search Space Name field, enter a name for the calling search space that will include the 
partition created in Step 2 through Step 4. For example, enter “VMRestrictedCSS.”

Step 11 If you want, in the Description field, enter a description of the calling search space. For example, enter 
“Voice mail port directory numbers.”

Step 12 In the Available Partitions field, double-click the name of the partition created in Step 2 through Step 4. 
For example, double-click “VMRestrictedPT.” For a diagram of the configuration, see Figure 2. For a 
diagram of the configuration with Cisco Unity failover, see Figure 3.

The name of the partition appears in the Selected Partitions field.

Step 13 Click Insert.

Step 14 Click Back to Find/List Calling Search Spaces.

Step 15 Click the name of the calling search space that is used by subscriber phones.

Step 16 In the Available Partitions field, double-click the name of the partition created in Step 5 through Step 7. 
For example, double-click “VMPilotNumberPT.” For a diagram of the configuration, see Figure 2. For 
a diagram of the configuration with Cisco Unity failover, see Figure 3.

Caution If the partition that contains the voice mail pilot number is not in the calling search space that 
is used by subscriber phones, the phones will not be able to dial the Cisco Unity server.

Step 17 Click Update.

Step 18 Repeat Step 15 through Step 17 for each remaining calling search space that needs to access 
Cisco Unity.
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Figure 2 Partitions for Voice Mail Port Directory Numbers

Figure 3 Partitions for Voice Mail Port Directory Numbers with Cisco Unity Failover
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To Add a Device Pool for the Voice Mail Ports

Step 1 In the Cisco CallManager Administration, click System > Device Pool.

Step 2 On the Device Pool Configuration page, enter the following device pool settings.

Step 3 Click Insert.

To Add Voice Mail Ports to Cisco CallManager

Add a voice mail port to Cisco CallManager for each port that you are connecting to Cisco Unity.

Step 1 In the Cisco CallManager Administration, click Feature > Voice Mail > Cisco Voice Mail Port 
Wizard.

Step 2 Click Create a New Cisco Voice Mail Server and Add Ports to It and click Next.

Step 3 The name of the voice mail server appears. We recommend that you accept the default name for the voice 
mail server, or, if necessary, enter a different name with no more than nine characters, then click Next.

The default name (CiscoUM), even if you do not use it, becomes part of the name for ports as follows:
<the voice mail server name>1 (for example, CiscoUM1).

Caution If Cisco Unity is configured for failover, the name of the voice mail server and voice mail 
ports that serve the secondary server must be different from the name of the voice mail server 
and voice mail ports that serve the primary server. Otherwise, the secondary server cannot 
function correctly.

Table 2 Settings for the Device Pool Configuration Page

Field Setting

Device Pool Name Enter Cisco Unity Voice Mail Ports or other description for this device 
pool.

Cisco CallManager Group Click the Cisco CallManager group to assign to the voice mail ports in 
this device pool.

Date/Time Group Click the date/time group to assign to the voice mail ports in this device 
pool.

Region Click the Cisco CallManager region to assign to the voice mail ports in 
this device pool.

Softkey Template Click the softkey template to assign to the voice mail ports in this device 
pool.

SRST Reference Click the survivable remote site telephony (SRST) reference to assign to 
the voice mail ports in this device pool.

Network Hold MOH Audio 
Source

Click None.

User Hold MOH Audio 
Source

Click None.
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Step 4 Enter the number of ports you want to add (which must not be more ports than the Cisco Unity license 
enables), then click Next.

If you will integrate Cisco Unity with multiple clusters of Cisco CallManager, the number you enter here 
cannot bring the total number of ports on all clusters integrated with Cisco Unity to more than the 
number of ports enabled by the Cisco Unity license.

Step 5 Enter the following voice mail device settings, then click Next.

Step 6 Enter the following voice mail directory number settings, then click Next.

Table 3 Settings for the Voice Mail Devices

Field Setting

Description Enter Cisco Voice Mail Port or other description that you want.

Device Pool Click the name of the device pool you created for the voice mail ports. For 
example, click Cisco Unity Voice Mail Ports.

Calling Search Space Click the name of a calling search space that allows calls to the subscriber 
phones and any required network devices.

This calling search space must include partitions that contain all devices 
Cisco Unity needs to access (for example, during call transfers, message 
notifications, and MWI activations).

Location Accept the default of None.

Table 4 Settings for the Voice Mail Directory Numbers

Field Setting

Pilot Number Enter the pilot number for the voice mail ports.

The pilot number is the extension number of the first voice mail port and 
is the number subscribers enter to listen to their voice messages.

If Cisco Unity is configured for failover and you are adding voice mail 
ports for the secondary server, the pilot number is the extension number of 
the first voice mail port on the secondary server, but it is not the number 
subscribers enter to listen to their voice messages.

Partition Click the name of the partition that you set up for all voice mail port 
directory numbers except the first voice mail port. For example, click 
“VMRestrictedPT.”
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Step 7 Enter the operator number or the number you want the last port to forward to when busy, if applicable, 
and click Next.

Step 8 The settings for the new ports appear. Click Finish.

Step 9 Click Go to Cisco Voice Mail Ports Page.

Note If Cisco Unity is configured for failover and you are setting ports for the secondary server, skip 
the remaining procedures in this section and continue to the “Creating a New Integration with 
the Cisco CallManager Phone System” section on page 17. For further instructions on 
configuring the voice mail ports, see the “Integrating a Secondary Server for Cisco Unity 
Failover” section on page 27.

To Set the Partition for the First Voice Mail Port

Step 1 On the Cisco Voice Mail Port Configuration page, in the Cisco Voice Mail Ports list, click the first voice 
mail port, which is assigned the voice mail pilot number.

Step 2 Under Directory Number Information, in the Partition field, click the partition that you set up to contain 
the first voice mail port. For example, click “VMPilotNumberPT.”

Step 3 Click Update.

To Specify MWI Directory Numbers

Step 1 In the Cisco CallManager Administration, click Feature > Voice Mail > Message Waiting.

Step 2 In the Message Waiting Directory Numbers list of the Message Waiting Configuration page, click Add 
a New Directory Number.

Step 3 Enter the following settings for turning MWIs on.

Calling Search Space Click the name of a calling search space that you set up to contain the 
partition with all voice mail port directory numbers except the first voice 
mail port, as set in Step 9 of the “To Add Partitions and a Calling Search 
Space to Contain the Voice Mail Ports” section on page 8. For example, 
click “VMRestrictedCSS.”

Because this calling search space is not used by subscriber phones, 
subscribers cannot dial any voice mail ports except the voice mail pilot 
number.

Display Accept the default of Voicemail. (This text appears on the phone when the 
pilot number is dialed.)

Caution If Cisco Unity is configured for failover, do not change the 
default setting for this field. Otherwise, the integration will not 
function correctly.

Table 4 Settings for the Voice Mail Directory Numbers (continued)
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Step 4 Click Insert.

Step 5 In the Message Waiting Directory Numbers list, click Add a New Directory Number.

Step 6 Enter the following settings for turning MWIs off.

Step 7 Click Insert.

To Add a Voice Mail Pilot Number for the Voice Mail Ports

The voice mail pilot number is the extension that you dial to listen to your voice messages. Your Cisco 
IP phone automatically dials the voice mail pilot number when you press the Messages button.

Step 1 In the Cisco CallManager Administration, click Feature > Voice Mail > Voice Mail Pilot.

Step 2 In the Voice Mail Pilot Numbers list of the Voice Mail Pilot Configuration page, click Add a New Voice 
Mail Pilot Number.

Step 3 Enter the following voice mail pilot number settings.

Table 5 Settings for Turning MWIs On

Field Setting

Directory Number Enter the unique extension that turns MWIs on.

Message Waiting 
Indicator

Click On.

Partition Click the name of the partition that you set up for the first voice mail port. 
For example, click “VMPilotNumberPT.”

Calling Search Space Click a calling search space that is used by subscriber phones.

Table 6 Settings for Turning MWIs Off

Field Setting

Directory Number Enter the unique extension that turns MWIs off.

Message Waiting 
Indicator

Click Off.

Partition Click the name of the partition that you set up for the first voice mail port. 
For example, click “VMPilotNumberPT.”

Calling Search Space Click a calling search space that is used by subscriber phones.

Table 7 Settings for the Voice Mail Pilot Number

Field Setting

Voice Mail Pilot Number Enter the pilot number for the voice mail ports. This number must be the 
same pilot number that you entered when adding voice mail ports earlier.

The pilot number is typically the extension number of the first voice mail 
port and is the number subscribers enter to listen to their voice messages.

Description Enter Cisco Unity Pilot or another description that you want.
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Step 4 Click Insert.

To Set Up the Voice Mail Profile

Step 1 In the Cisco CallManager Administration, click Feature > Voice Mail > Voice Mail Profile.

Step 2 In the Find and List Voice Mail Profiles page, click Add a New Voice Mail Profile.

Step 3 In the Voice Mail Profiles Configuration page, enter the following voice mail profile settings.

Step 4 Click Insert.

To Set Up the Voice Mail Server Service Parameters

Step 1 In the Cisco CallManager Administration, click Service > Service Parameters.

Calling Search Space Click the calling search space that includes partitions containing the 
subscriber phones and the partition you set up for the first voice mail port.

Make This the Default 
Voice Mail Pilot for the 
System

Check this check box. When this check box is checked, this voice mail 
pilot number replaces the current default pilot number.

Table 7 Settings for the Voice Mail Pilot Number (continued)

Table 8 Settings for the Voice Mail Profile

Field Setting

Voice Mail Profile Name Enter a name to identify the voice mail profile.

Description Enter Cisco Unity Profile or another description that you want.

Voice Mail Pilot Click one of the following:

• The applicable voice mail pilot number that you defined in the Voice 
Mail Pilot Configuration

• None (to use the default voice mail pilot number)

Voice Mail Box Mask When multitenant services are not enabled on Cisco CallManager, leave 
this field blank.

When multitenant services are enabled, each tenant uses its own voice mail 
profile. Create a mask to identify the extensions (directory numbers) in 
each partition. For example, one tenant can use a mask 972813XXXX, 
while another tenant can use the mask 214333XXXX. It is also necessary 
to set up translation patterns for MWIs.

Make This the Default 
Voice Mail Profile for the 
System

Check this check box to make this voice mail profile the default.

If you check the check box, this voice mail profile replaces the current 
default voice mail profile.
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Step 2 In the Server field on the Service Parameters Configuration page, click the voice mail server that you 
created earlier.

Step 3 In the Services list, click Cisco CallManager. The list of parameters appears.

Step 4 Scroll down the list until you locate the parameters listed in Table 9 (about three-quarters of the way).

Step 5 Enter the parameter settings shown in the following table.

Step 6 Click Update to save the settings.

Step 7 Click Select Another Service at the top of the page.

Step 8 In the Services list, click Cisco Messaging Interface. The list of parameters appears.

Step 9 Confirm that the VoiceMailDn parameter setting is blank.

Step 10 If you changed the parameter setting to blank, click Update to save the setting.

Step 11 Shut down and restart the Cisco CallManager server.

If the plan for voice mail ports in Cisco Unity (see the “Planning How the Voice Messaging Ports Will 
Be Used by Cisco Unity” section on page 5) includes ports that do not answer calls (for example, ports 
that only dial out to set MWIs), do the following procedure so that incoming calls are not forwarded to 
these ports.

Table 9 Settings for the Service Parameters

Service Parameter to Configure Setting

Voice Mail Maximum Hop Count Used together with AdvancedCallForwardHopFlag, the maximum 
number of voice mail ports skipped to find the next available voice 
mail port. Specify a value that is three less than the number of 
Cisco CallManager ports that are connected to the Cisco Unity 
server. For example, if you have a 48-port Cisco Unity system, 
enter 45 for this setting.

If you have configured failover for Cisco Unity, specify a value 
that is three less than the total number of Cisco CallManager ports 
that are connected to both Cisco Unity servers. For example, if the 
primary and secondary Cisco Unity servers each have 48 ports, 
enter 93 for this setting.

Multiple Tenant MWI Modes Enables multitenant MWI notification. When set to True, 
Cisco CallManager uses any configured translation patterns to 
convert voice mail extensions into directory numbers when 
turning on or off an MWI.

H225 DTMF Duration Specifies the duration (in milliseconds) of outbound DTMF digits 
for H.323 devices.

If you will use the Cisco Unity Bridge or AMIS to connect Cisco 
CallManager and Cisco Unity to a supported third-party voice 
messaging system, confirm that this parameter is set to 100.

Advanced CallForward Hop Flag Enables Cisco CallManager to skip busy or unregistered voice 
mail ports when searching for an available voice mail port. Set to 
True.
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To Set Up Voice Mail Ports So Incoming Calls Are Forwarded Only to Answering Ports

Step 1 In the Cisco CallManager Administration, click Feature > Voice Mail > Cisco Voice Mail Port.

Step 2 In the Cisco Voice Mail Ports list of the Cisco Voice Mail Port Configuration page, click the name of the 
last voice mail port that answers calls in Cisco Unity.

Step 3 Set the Forward Busy and Forward No Answer fields to forward to the first voice mail port that answers 
calls in Cisco Unity.

Step 4 Click Update.

Step 5 In the Cisco Voice Mail Ports list, click the name of a the first voice mail port that does not answer calls 
in Cisco Unity.

Step 6 Under Call Forwarding Information, delete the extensions in the Forward Busy field, and set the Forward 
No Answer field to forward to the first voice mail port that answers calls in Cisco Unity.

Step 7 Click Update.

Step 8 Repeat Step 5 through Step 7 for all remaining voice mail ports that do not answer calls in Cisco Unity.

If the Cisco Unity server services multiple clusters of Cisco CallManager, do the following procedure to 
enable MWIs to be activated on extensions in each cluster.

To Set Up MWI Voice Mail Ports for Multiple Clusters of Cisco CallManager

Step 1 In the Cisco Unity Administrator, select at least one voice mail port per cluster to be dedicated for 
sending MWIs to each cluster. For example, if the system has four clusters, dedicate at least four ports 
to send only MWIs, one port from each cluster.

Step 2 In the Cisco CallManager Administration, click Feature > Voice Mail > Cisco Voice Mail Port.

Step 3 In the Cisco Voice Mail Ports list of the Cisco Voice Mail Port Configuration page, click the name of the 
port before the first dedicated MWI port.

Step 4 Under Call Forwarding Information, change the extensions to the number of the first voice mail port or 
of the operator.

Step 5 Click Update.

Step 6 In the Cisco Voice Mail Ports list, click the name of a dedicated MWI port.

Step 7 Under Call Forwarding Information, delete the extensions so that the fields are empty and call 
forwarding for this port is disabled.

Step 8 Click Update.

Step 9 Repeat Step 6 through Step 8 for all remaining dedicated MWI ports.

You can use alternate extensions to create multiple line appearances, enable easy message access from 
cell phones, and simplify addressing messages to subscribers at different locations in Cisco Unity. When 
you enable alternate MWIs, Cisco Unity can turn MWIs on at more than one extension. For details, see 
the “Appendix: Using Alternate Extensions and MWIs” section on page 32.
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Setting Up the Gateways That Service Cisco Unity
In certain situations, DTMF digits are not recognized when processed through VoIP dial-peer gateways. 
To avoid this problem, certain gateways must be configured to enable DTMF relay. The DTMF relay 
feature is available in Cisco IOS software version 12.0(5) and later.

Cisco IOS software-based gateways that use H.245 out-of-band signaling must be configured to enable 
DTMF relay.

Enable dtmf-relay h245-alphanumeric on this dial-peer.

The Catalyst 6000 T1/PRI and FXS gateways enable DTMF relay by default and do not need additional 
configuration to enable this feature.

To Enable DTMF Relay

Step 1 On a VoIP dial-peer servicing Cisco Unity, use the following command:

dtmf-relay h245-alphanumeric

Step 2 Create a destination pattern that matches the Cisco CallManager voice mail port numbers. For example, 
if the system has voice mail ports 1001 through 1016, enter the dial-peer destination pattern 10xx.

Step 3 Repeat Step 1 and Step 2 for all remaining VoIP dial-peers servicing Cisco Unity.

Creating a New Integration with the Cisco CallManager Phone 
System

After ensuring that the Cisco CallManager phone system and the Cisco Unity server are ready for the 
integration, do the following procedures to set up the integration and to enter the port settings.

Note If you are integrating with multiple clusters of Cisco CallManager, you must integrate Cisco Unity with 
each additional cluster. Skip to the “To Create an Integration with a Second Cluster of 
Cisco CallManager” procedure on page 21.

To Create an Integration

Step 1 If UTIM is not already open, on the Windows Start menu, click Programs > Cisco Unity > Manage 
Integrations. UTIM appears.

Step 2 On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard 
appears.

Step 3 On the Welcome page, click Cisco CallManager, then click Next.

Step 4 On the Name Cisco CallManager Integration and Cluster page, enter the following settings, then click 
Next.
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Step 5 On the Enter Cisco CallManager IP Address and Port page, enter the following settings, then click Next.

You can click Ping Server to confirm that the IP address is correct.

Step 6 On the Enter Secondary Server Settings page, in the IP Address/Name field, enter the IP address (or DNS 
name) and port of all remaining subscriber (secondary) Cisco CallManager servers in the cluster and of 
the publisher (primary) Cisco CallManager server. Then click Add after entering each so that the IP 
addresses of all secondary servers appear in the list. If there is only one Cisco CallManager server in the 
cluster, leave this page blank.

The IP addresses of the subscriber (secondary) Cisco CallManager servers must appear in descending 
order, so that the subscriber (secondary) Cisco CallManager server at the top of the list is the first to take 
over call processing functions during failover, and the publishing (primary) Cisco CallManager server 
is the last.

You can click Ping Servers to confirm that the IP addresses are correct.

Step 7 If you want Cisco Unity to automatically reconnect to the primary Cisco CallManager server after 
failover has been corrected, check the Reconnect to Primary Cisco CallManager Server check box.

Step 8 Click Next.

Step 9 On the Enter Cisco CallManager MWI Extensions page, enter the following settings, then click Next.

Step 10 On the Set Number of Voice Messaging Ports page, enter the following settings, then click Next.

Table 10 Settings for the Name Cisco CallManager Integration and Cluster Page

Field Setting

Integration Name <the name you will use to identify this Cisco CallManager integration; accept 
the default name or enter another name>

Cluster Name <the name you will use to identify this Cisco CallManager cluster; accept the 
default name or enter another name>

Table 11 Settings for the Enter Cisco CallManager IP Address and Port Page

Field Setting

IP Address/Name <the IP address (or DNS name) of the Cisco CallManager server that you are 
connecting to Cisco Unity; if you are connecting to a Cisco CallManager 
cluster, we recommend entering the IP address (or DNS name) of a subscriber 
(secondary) Cisco CallManager server>

TCP Port <the TCP port of the Cisco CallManager server that you are connecting to 
Cisco Unity; we recommend using the default setting>

Table 12 Settings for the Enter CallManager MWI Extensions Page

Field Setting

MWI On Extension <the extension you specified in Cisco CallManager Administration for turning 
MWIs on>

MWI Off Extension <the extension you specified in Cisco CallManager Administration for turning 
MWIs off>
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You can click Verify to confirm that the CallManager device name prefix is correct.

Step 11 If another integration already exists, the Enter Trunk Access Code page appears. Enter the extra digits 
that Cisco Unity must use to transfer calls through the gateway to extensions on the other phone system 
with which it is integrated. Then click Next.

Step 12 On the Completing page, verify the settings you entered, then click Finish.

Step 13 At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Alternatively, you can restart the Cisco Unity services in UTIM on the Tools menu by clicking Restart 
Cisco Unity. Do not use the taskbar icon to restart the Cisco Unity for UTIM changes because the 
taskbar icon does not restart all of the Cisco Unity services.

To Enter the Voice Messaging Port Settings for the Integration

Step 1 After the Cisco Unity services restart, on the Windows Start menu, click Programs > Cisco Unity > 
Manage Integrations. UTIM appears.

Step 2 In the left pane of the UTIM window, click the phone system integration you are creating.

Step 3 In the right pane, click the phone system or cluster name.

Step 4 In the right pane, click the Ports tab.

Step 5 Enter the settings shown in Table 14 for the voice messaging ports.

For the voice messaging ports assigned to a given Cisco CallManager cluster, to get the best performance 
use the first voice messaging ports for incoming calls and the last ports to dial out. This helps minimize 
the possibility of a collision, in which an incoming call arrives on a port at the same time that Cisco Unity 
takes the port off-hook to dial out. Set the ports assigned to each Cisco CallManager cluster in this 
manner.

If the Cisco Unity server is connected to multiple clusters of Cisco CallManager and if the Cisco 
CallManager server has dedicated MWI voice messaging ports, set each dedicated MWI voice 
messaging port to Dialout MWI. For example, if the system has four clusters, dedicate four ports to send 
only MWIs, and assign one port to each cluster.

Table 13 Settings for the Set Number of Voice Messaging Ports Page

Field Setting

Number of Ports <the number of voice messaging ports connecting Cisco Unity to the 
Cisco CallManager server; if Cisco Unity is connected to a single 
Cisco CallManager server, this number cannot be more than the number of 
ports set up on Cisco CallManager; if Cisco Unity is connected to multiple 
clusters of Cisco CallManager, this number cannot be more than the number of 
ports set up on the Cisco CallManager cluster, and the total number of ports on 
all clusters connected to Cisco Unity cannot be more than the number of ports 
enabled by the Cisco Unity license>

CallManager Device 
Name Prefix

<the prefix Cisco CallManager adds to the device name for voice messaging 
ports; this prefix must match the prefix used by Cisco CallManager>
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Caution In programming Cisco CallManager, do not send calls to voice messaging ports in 
Cisco Unity that cannot answer calls (voice messaging ports that are not set to Answer Calls). 
For example, if a voice messaging port is set only to Dialout MWI, do not send calls to it.

Step 6 Repeat Step 5 for the remaining clusters, if any.

Step 7 Click Save.

Step 8 If Cisco Unity integrates with only one cluster of Cisco CallManager, exit UTIM, skip the remaining 
procedures in this section, and continue to the “Testing the Integration” section.

Table 14 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a 
ringing tone but are not answered. Typically, the port is disabled only by the installer during 
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming 
calls from unidentified callers or from subscribers. As a general guideline, set Answer Calls 
on approximately 75 percent of the ports.

Message Notification Check this check box to designate the port for notifying subscribers of messages. Assign 
Message Notification to the least busy ports, which typically are those with the highest port 
numbers for the phone system. As a general guideline, set Message Notification, Dialout 
MWI, and TRAP Connection on approximately 25 percent of the ports.

Dialout MWI

(not used by serial or SMDI 
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI 
to the least busy ports, which typically are those with the highest port numbers for the phone 
system. As a general guideline, set Message Notification, Dialout MWI, and TRAP 
Connection on approximately 25 percent of the ports.

AMIS Delivery

(available with the AMIS 
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice 
messages from Cisco Unity subscribers to users on another voice messaging system. 
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol, 
which provides an analog mechanism for transferring voice messages between different 
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long 
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule 
page so that outgoing AMIS calls are placed during closed hours or at times when 
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback 
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the 
least busy ports, which typically are those with the highest port numbers for the phone 
system. As a general guideline, set Message Notification, Dialout MWI, and TRAP 
Connection on approximately 25 percent of the ports.
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If Cisco Unity integrates with multiple clusters of Cisco CallManager, continue to the next procedure.

To Create an Integration with a Second Cluster of Cisco CallManager

If Cisco Unity integrates with only one cluster of Cisco CallManager, skip this procedure.

Step 1 In the left pane of the UTIM window, click the Cisco CallManager integration.

Step 2 On the Cluster menu, click New. A new cluster appears in the Cisco CallManager integration.

Step 3 Click the Servers tab, and enter the following settings.

Step 4 Click the MWI tab, and enter the following settings.

Table 15 Settings for the Servers Tab

Field Setting

Display Name Enter Cisco CallManager Cluster 02 or another name you will use to identify 
this Cisco CallManager cluster.

Primary Server

IP Address/Name <the IP address (or DNS name) of a subscriber (secondary) Cisco CallManager 
server>

Port <the TCP port of the Cisco CallManager server that you are connecting to 
Cisco Unity; we recommend using the default setting>

CallManager Device 
Name Prefix

<the prefix Cisco CallManager adds to the device name for voice messaging 
ports; this prefix must match the prefix used by the Cisco CallManager 
cluster>

Secondary Servers

IP Address/Name <the IP address (or DNS name) of all remaining subscriber (secondary) 
Cisco CallManager servers in the cluster and the publisher (primary) 
Cisco CallManager server; then click Add after entering each so that the IP 
addresses of all secondary servers appear in the Address list; if there is only 
one Cisco CallManager server in the cluster, leave this field blank>

Port <the TCP port of the Cisco CallManager server that you are connecting to 
Cisco Unity; we recommend using the default setting>

Reconnect to the 
Primary 
Cisco CallManager 
server

Check this check box if you want Cisco Unity to automatically reconnect to the 
primary Cisco CallManager server in the cluster after failover has been 
corrected.

Table 16 Settings for the MWI Tab

Field Setting

On Extension <the extension you specified in Cisco CallManager Administration of the 
cluster for turning MWIs on>

Off Extension <the extension you specified in Cisco CallManager Administration of the 
cluster for turning MWIs off>
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Step 5 Click the Ports tab, and click Add Port.

Step 6 In the Add Port dialog box, enter the number of voice messaging ports on Cisco Unity you want to 
connect to the Cisco CallManager cluster, and click OK.

This number cannot be more than the number of ports set up on the Cisco CallManager cluster. This 
number cannot bring the total number of port installed on the Cisco Unity server to more than the number 
of ports enabled by the Cisco Unity license.

Step 7 Click the Servers tab, and click Verify Servers to confirm that the Cisco CallManager server 
information is correct.

Step 8 Click the RTP tab, and confirm that the Automatically Assign option is selected.

Step 9 In the UTIM window, click Save.

Step 10 At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Note When restarting Cisco Unity, use the UTIM prompt instead of the Cisco Unity icon in the 
Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

Step 11 After the Cisco Unity services restart, on the Windows Start menu, click Programs > Cisco Unity > 
Manage Integrations. UTIM appears.

Step 12 In the left pane of the UTIM window, click the Cisco CallManager integration.

Step 13 In the right pane, click the name of the cluster name you created in this procedure.

Step 14 In the right pane, click the Ports tab.

Step 15 Enter the settings shown in Table 17 for the voice messaging ports.

Caution In programming Cisco CallManager, do not send calls to voice messaging ports in 
Cisco Unity that cannot answer calls (voice messaging ports that are not set to Answer Calls). 
For example, if a voice messaging port is set only to Dialout MWI, do not send calls to it.

Table 17 Settings for the Voice Messaging Ports

Field Considerations

Extension Enter the extension for the port as assigned on the phone system.

Enabled Check this check box to enable the port. The port is enabled during normal operation.

Uncheck this check box to disable the port. When the port is disabled, calls to the port get a 
ringing tone but are not answered. Typically, the port is disabled only by the installer during 
testing.

Answer Calls Check this check box to designate the port for answering calls. These calls can be incoming 
calls from unidentified callers or from subscribers. As a general guideline, set Answer Calls 
on approximately 75 percent of the ports.

Message Notification Check this check box to designate the port for notifying subscribers of messages. Assign 
Message Notification to the least busy ports, which typically are those with the highest port 
numbers for the phone system. As a general guideline, set Message Notification, Dialout 
MWI, and TRAP Connection on approximately 25 percent of the ports.
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Step 16 In the UTIM window, click Save.

Step 17 Exit UTIM.

Step 18 Repeat Step 1 through Step 17 for all remaining Cisco CallManager clusters.

Testing the Integration
To test whether Cisco Unity and the phone system are integrated correctly, do the following procedures 
in the order listed.

If any of the steps indicates a failure, refer to the following documentation as applicable:

• The installation guide for the phone system

• Cisco Unity Troubleshooting Guide, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_troubleshooting_guides_list.html

• The setup information earlier in this guide

To Set Up the Test Configuration

Step 1 Set up two test extensions (Phone 1 and Phone 2) on the same phone system that Cisco Unity is 
connected to.

Step 2 Set Phone 1 to forward calls to the Cisco Unity pilot number when calls are not answered.

Dialout MWI

(not used by serial or SMDI 
integrations)

Check this check box to designate the port for turning MWIs on and off. Assign Dialout MWI 
to the least busy ports, which typically are those with the highest port numbers for the phone 
system. As a general guideline, set Message Notification, Dialout MWI, and TRAP 
Connection on approximately 25 percent of the ports.

AMIS Delivery

(available with the AMIS 
licensed feature only)

Check this check box to designate the port for making outbound AMIS calls to deliver voice 
messages from Cisco Unity subscribers to users on another voice messaging system. 
Cisco Unity supports the Audio Messaging Interchange Specification (AMIS) protocol, 
which provides an analog mechanism for transferring voice messages between different 
voice messaging systems.

This setting affects outbound AMIS calls only. All ports are used for incoming AMIS calls.

Because the transmission of outgoing AMIS messages may tie up voice ports for long 
periods of time, you may want to adjust the schedule on the Network > AMIS > Schedule 
page so that outgoing AMIS calls are placed during closed hours or at times when 
Cisco Unity is not processing many calls.

TRAP Connection Check this check box so that subscribers can use the phone as a recording and playback 
device in Cisco Unity web applications and e-mail clients. Assign TRAP Connection to the 
least busy ports, which typically are those with the highest port numbers for the phone 
system. As a general guideline, set Message Notification, Dialout MWI, and TRAP 
Connection on approximately 25 percent of the ports.

Table 17 Settings for the Voice Messaging Ports (continued)

Field Considerations
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Step 3 In the Cisco Unity Administrator, create a test subscriber to use for testing by doing the applicable 
substeps below.

If your message store is Microsoft Exchange, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

b. Click the Add icon.

c. Select New Exchange Subscriber.

d. Enter the applicable information on the Add Subscriber page.

e. Click Add.

If your message store is IBM Lotus Domino, do the following:

a. In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

b. Click the Add icon.

c. Click Notes.

d. In the Address Book list, confirm that the address book listed is the one that contains the user data 
that you want to import.

If the address book that you want to use is not listed, go to the System > Configuration > 
Subscriber Address Books page and add a different address book.

e. In the Find Domino Person By list, indicate whether to search by short name, first name, or last 
name.

f. Enter the applicable short name or name. You also can enter * to display a list of all users, or enter 
one or more characters followed by * to narrow your search.

g. Click Find.

h. On the list of matches, click the name of the user to import.

i. Enter the applicable information on the Add Subscriber page.

j. Click Add.

Step 4 In the Extension field, enter the extension of Phone 1.

Step 5 In the Active Schedule field, click All Hours - All Days.

Step 6 Click the Save icon.

Step 7 In the navigation bar, click Call Transfer to go to the Subscribers > Subscribers > Call Transfer page 
for the test subscriber.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings” 
section in the Cisco Unity Administrator Help.

Step 8 Under Transfer Incoming Calls, click Yes, Ring Subscriber’s Extension, and confirm that the extension 
number is for Phone 1.

Step 9 Under Transfer Type, click Release to Switch.

Step 10 Click the Save icon.

Step 11 In the navigation bar, click Messages to go to the Subscribers > Subscribers > Messages page for the test 
subscriber.

Step 12 Under Message Waiting Indicators (MWIs), check Use MWI for Message Notification.

Step 13 In the Extension field, enter x.

Step 14 Click the Save icon.
24
Cisco CallManager 3.2 Integration Guide for Cisco Unity 4.0

OL-3011-06



 

Cisco CallManager 3.2 Integration Guide for Cisco Unity 4.0
Testing the Integration
Step 15 Open the Status Monitor by doing one of the following:

• In Internet Explorer, go to http://<Cisco Unity server name>/web/sm.

• Double-click the desktop shortcut to the Status Monitor.

• In the status bar next to the clock, right-click the Cisco Unity tray icon and click Status Monitor.

To Test an External Call with Release Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside 
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note the port that handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting 
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you hear a ringback tone on Phone 2. Hearing a ringback tone means 
that Cisco Unity released the call and transferred it to Phone 1.

Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call changes to “Idle.” This 
state means that release transfer is successful.

Step 6 Confirm that, after the number of rings that the phone system is set to wait, the call is forwarded to 
Cisco Unity and that you hear the greeting for the test subscriber. Hearing the greeting means that the 
phone system forwarded the unanswered call and the call-forward information to Cisco Unity, which 
correctly interpreted the information.

Step 7 On the Status Monitor, note the port that handles this call.

Step 8 Leave a message for the test subscriber and hang up Phone 2.

Step 9 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

Step 10 Confirm that the MWI on Phone 1 is activated. The activated MWI means that the phone system and 
Cisco Unity are successfully integrated for turning on MWIs.

To Test an Internal Call with Release Transfer

Step 1 From Phone 1, enter the internal pilot number for Cisco Unity.

Step 2 When asked for your password, enter 12345. Hearing the request for your password means that the phone 
system sent the necessary call information to Cisco Unity, which correctly interpreted the information.

Step 3 Confirm that you hear the recorded voice name for the test subscriber (if you did not record a voice name 
for the test subscriber, you will hear the extension number for Phone 1). Hearing the voice name means 
that Cisco Unity correctly identified the subscriber by the extension.

Step 4 When asked whether you want to listen to your message, press 1.

Step 5 After listening to the message, press 3 to delete the message.

Step 6 Confirm that the MWI on Phone 1 is deactivated. The deactivated MWI means that the phone system and 
Cisco Unity are successfully integrated for turning off MWIs.

Step 7 Hang up Phone 1.
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Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

To Set Up Supervised Transfer on Cisco Unity

Step 1 In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Call Transfer page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title 
bar, then click Find, and select the name of the test subscriber in the list that appears.

For more information on transfer settings, refer to the “Subscriber Template Call Transfer Settings” 
section in the Cisco Unity Administrator Help.

Step 2 Under Transfer Type, click Supervise Transfer.

Step 3 Set the Rings to Wait For field to 3.

Step 4 Click the Save icon.

To Test Supervised Transfer

Step 1 From Phone 2, enter the access code necessary to get an outside line, then enter the number outside 
callers use to dial directly to Cisco Unity.

Step 2 On the Status Monitor, note the port that handles this call.

Step 3 When you hear the opening greeting, enter the extension for Phone 1. Hearing the opening greeting 
means that the port is configured correctly.

Step 4 Confirm that Phone 1 rings and that you do not hear a ringback tone on Phone 2. Instead, you should 
hear the indication your phone system uses to mean that the call is on hold (for example, music or beeps).

Step 5 Leaving Phone 1 unanswered, confirm that the state of the port handling the call remains “Busy.” This 
state and hearing an indication that you are on hold mean that Cisco Unity is supervising the transfer.

Step 6 Confirm that, after three rings, you hear the greeting for the test subscriber. Hearing the greeting means 
that Cisco Unity successfully recalled the supervised-transfer call.

Step 7 During the greeting, hang up Phone 2.

Step 8 On the Status Monitor, confirm that the state of the port handling the call changes to “Idle.” This state 
means that the port was successfully released when the call ended.

To Delete the Test Subscriber

Step 1 In the Cisco Unity Administrator, go to the Subscribers > Subscribers > Profile page.

If the name of the test subscriber is not displayed, click the Find icon (the magnifying glass) in the title 
bar, then click Find, and select the name of the test subscriber in the list that appears.

Step 2 In the title bar, click the Delete Subscriber icon (the X).

Step 3 Click Delete.
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Integrating a Secondary Server for Cisco Unity Failover
The Cisco Unity failover feature enables a secondary server to provide voice messaging services when 
the primary server becomes inactive. For information on installing a secondary server for failover, refer 
to the Cisco Unity Installation Guide, available at 
http://www.cisco.com/en/US/products/sw/voicesw/ps2237/prod_installation_guides_list.html.

For information on failover, refer to the Cisco Unity Failover Configuration and Administration Guide, 
available at http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/fail/fail401/ex/index.htm.

Requirements
The following components are required to integrate a secondary server:

• One secondary server for each primary server installed and ready for the integration, as described in 
the Cisco Unity Installation Guide and earlier in this integration guide.

• A license that enables failover.

Integration Description
The phone system communicates with both the primary and secondary servers through the LAN. 
Figure 4 shows the required connections.

Figure 4 Connections Between Cisco CallManager and the Cisco Unity Servers

The primary and secondary servers act in the following manner:

• When the primary server is operating normally, the secondary server is inactive.

• When the primary server becomes inactive, the secondary server becomes active.

• When the primary server becomes active again, the secondary server becomes inactive.
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Setting Up the Secondary Server for Failover
Before proceeding, confirm that Cisco CallManager is configured as described in the “Programming the 
Cisco CallManager Phone System” section earlier in this integration guide, including the following:

• For each voice mail port, the Forward Busy and Forward No Answer fields are set to forward to the 
next voice mail port (the default configuration of the Cisco Voice Mail Wizard).

• The name of the voice mail server and voice mail ports that serve the secondary server are different 
from the name of the voice mail server and voice mail ports that serve the primary server.

Do the following two procedures to integrate the secondary server.

To Configure Cisco CallManager

Step 1 In the Cisco CallManager Administration, click Feature > Voice Mail > Cisco Voice Mail Port.

Step 2 For the last voice mail port that answers calls on the primary server, set the Forward Busy field to the 
first voice mail port on the primary server.

If there are voice mail ports on the primary server that do not answer calls (for example, voice mail ports 
set only to Dialout MWI), leave the Forward Busy field blank.

Caution In programming Cisco CallManager, do not send calls to ports in Cisco Unity that cannot 
answer calls (ports that are not set to Answer Calls). For example, if a port is set only to 
Dialout MWI, do not send calls to it.

For a diagram of the voice mail port settings, see Figure 5.

Step 3 For all voice mail ports that answer calls on the primary server, set the Forward No Answer field to the 
first voice mail port on the secondary server.

If there are voice mail ports on the primary server that do not answer calls (for example, voice mail ports 
set only to Dialout MWI), set the Forward No Answer field to the first voice mail port on the primary 
server.

Caution In programming Cisco CallManager, do not send calls to ports in Cisco Unity that cannot 
answer calls (ports that are not set to Answer Calls). For example, if a port is set only to 
Dialout MWI, do not send calls to it.

For a diagram of the voice mail port settings, see Figure 5.

Step 4 For the last voice mail port that answers calls on the secondary server, set the Forward Busy and Forward 
No Answer fields to the first voice mail port on the secondary server.

If there are voice mail ports on the secondary server that do not answer calls (for example, voice mail 
ports set only to Dialout MWI), leave the Forward Busy field blank and set the Forward No Answer field 
to the first voice mail port on the secondary server.

Caution In programming Cisco CallManager, do not send calls to ports in Cisco Unity that cannot 
answer calls (ports that are not set to Answer Calls). For example, if a port is set only to 
Dialout MWI, do not send calls to it.
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For a diagram of the voice mail port settings, see Figure 5.

Figure 5 Cisco CallManager Voice Mail Port Configuration for Cisco Unity Failover

To Set Up the Secondary Server for Failover

Step 1 Install a secondary server with the same configuration as the primary server. For installation instructions, 
refer to the Cisco Unity Installation Guide.

Step 2 On the Windows Start menu of the secondary server, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 3 On the Integration menu of the UTIM window, click New. The Telephony Integration Setup Wizard 
appears.

Step 4 Enter the settings to match the integration settings on the primary server.

Step 5 At the prompt to restart the Cisco Unity server, click Yes. The Cisco Unity server restarts.

Note When restarting Cisco Unity, use the UTIM prompt instead of the Cisco Unity icon in the 
Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

Step 6 After Cisco Unity restarts, on the Windows Start menu of the Cisco Unity server, click Programs > 
Cisco Unity > Manage Integrations. UTIM appears.

Step 7 In the left pane of the UTIM window, click the phone system integration you created in Step 4.
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Step 8 In the right pane of the UTIM window, click the Ports tab.

Step 9 Enter the port settings to match the port settings on the primary server.

Step 10 Click Save.

Step 11 Exit UTIM.

Changing the Settings for an Existing Integration
After the integration is set up, if you want to change any of its settings (for example, to change the MWI 
settings), do the following procedure.

If you want to change the number of voice messaging ports, see the “Changing the Number of Voice 
Messaging Ports” section on page 30.

To Change the Settings for an Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 2 In the left pane, double-click Unity Server. The existing integrations appear.

Step 3 Click the integration you want to modify.

Step 4 In the right pane, click the cluster for the integration.

Step 5 In the right pane, click the applicable tab for the integration.

Step 6 Enter new settings in the fields that you want to change.

Caution If you are adding or removing voice messaging ports, make sure you change the settings for 
the individual ports so that there are an appropriate number of ports set to answer calls and an 
appropriate number of ports set to dial out.

Step 7 In the UTIM window, click Save.

Step 8 If prompted, restart the Cisco Unity services.

Changing the Number of Voice Messaging Ports
To change the number of voice messaging ports after you have finished installing and setting up Cisco 
CallManager, do the following procedures.

To Change the Number of Voice Messaging Ports in the Cisco CallManager Administration

Step 1 On the Cisco CallManager server, use the Cisco Voice Mail Port Wizard to add or remove voice 
messaging ports, as applicable.
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For information on adding voice messaging ports, see the “To Add Voice Mail Ports to Cisco 
CallManager” section on page 10. For information on removing voice mail ports, refer to the Cisco 
CallManager Administrator Help.

Step 2 Continue with the next procedure.

To Update Cisco Unity for Additional Voice Messaging Ports

Step 1 If the Cisco Unity license does not enable the additional voice messaging ports you added, see your sales 
representative to request the applicable license.

Step 2 When you have the license, on the Cisco Unity server, click Programs > Cisco Unity > Licensing.

Step 3 On the Action menu, click Install License Files.

Step 4 Follow the on-screen instructions.

Note If you increase the number of voice messaging ports from 32 or fewer to more than 32, you must 
also install SQL Server 2000 as described in the Cisco Unity Installation Guide.

Step 5 Continue with the “Changing the Settings for an Existing Integration” section on page 30.

Deleting an Existing Integration
If you want to delete an existing integration (for example, you have replaced the phone system with 
which Cisco Unity originally integrated), do the following procedure.

To Delete an Existing Integration

Step 1 On the Cisco Unity server, on the Windows Start menu, click Programs > Cisco Unity > Manage 
Integrations. The UTIM window appears.

Step 2 In the left pane, double-click Unity Server. The existing integrations appear.

Step 3 Click the integration that you want to delete.

Step 4 On the Integration menu, click Delete.

Step 5 Follow the on-screen instructions to assign the subscribers of the deleted phone system integration to 
another phone system integration.

Step 6 At the prompt to restart the Cisco Unity services, click Yes. The Cisco Unity services restart.

Note When restarting Cisco Unity, use the UTIM prompt instead of the Cisco Unity icon in the 
Windows taskbar. The taskbar icon does not restart all of the Cisco Unity services.

Step 7 If the integration you deleted used voice cards, remove the voice cards from the Cisco Unity server.
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Troubleshooting the Cisco CallManager Integration
This section provides information about common integration problems.

Cisco Unity Does Not Answer When the Extension for Cisco Unity Is Dialed
If you hear a fast busy or number unobtainable signal when you dial Cisco Unity, do the following 
procedure.

To Confirm That the Phone System Programming Is Complete

Step 1 Review the phone system programming to confirm that it is complete. Specific actions to take are:

• Confirming that the voice mail ports are correctly set up. For details, see the “To Add Voice Mail 
Ports to Cisco CallManager” section on page 10.

• Confirming that the voice mail ports and phones are in the same calling search space. For details, 
see the “To Add Voice Mail Ports to Cisco CallManager” section on page 10.

Step 2 Exit the Cisco Unity software, then restart the server.

Appendix: Using Alternate Extensions and MWIs

Alternate Extensions
In addition to the “primary” extension that you specify for subscribers, you can assign subscribers up to 
nine alternate extensions. (The primary extension is the one that you assign to each subscriber when you 
create his or her subscriber account; it is listed on the Subscribers > Subscribers > Profile page.) 

Reasons to Use Alternate Extensions

There are several reasons why you may want to specify alternate extensions for subscribers. For 
example, if you have more than one Cisco Unity server that accesses a single, corporate-wide directory, 
you may want to use alternate extensions so that a subscriber uses the same number when addressing a 
message to a subscriber associated with another Cisco Unity server and when calling that subscriber 
directly. You may also want to use alternate extensions to:

• Handle multiple line appearances on subscriber phones.

• Offer easy message access on direct calls from a cell phone, home phone, or phone at an alternate 
work site (assuming that the phone number is passed along to Cisco Unity from these other phone 
systems). In addition, when such phones are used as alternate extensions, and are set to forward to 
Cisco Unity, callers can listen to the subscriber greeting, and leave messages for the subscriber just 
as they would when dialing the primary extension for the subscriber.
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Tip To reduce the number of requests from subscribers who want alternate extensions set up for 
multiple cell phones, home phones, and other phones, give subscribers class of service (COS) 
rights to specify their own set of alternate extensions. (See the Subscribers > Class of Service > 
Profile page.) With proper COS rights, a subscriber can specify up to five alternate extensions 
in the Cisco Unity Assistant—in addition to the nine that you can specify on the Subscribers > 
Alternate Extensions page in the Cisco Unity Administrator.

• Simplify addressing messages to subscribers at different locations. With alternate extensions, the 
number that a subscriber uses when addressing a message to someone at another location can be the 
same number that the subscriber dials when calling.

• Enable URL-based extensions in Cisco Unity for an integration with a SIP phone system.

How Alternate Extensions Work

Before you set up alternate extensions, review the following list for information on how alternate 
extensions work:

• Alternate extensions cannot exceed 30 characters in length. By default, each administrator-defined 
alternate extension must be at least 3 characters in length, while subscriber-defined alternate 
extensions must be at least 10 characters. 

You can use the Advanced Settings tool in Tools Depot to specify a minimum extension length for 
the extensions entered in the Cisco Unity Administrator and the Cisco Unity Assistant. Refer to the 
Advanced Settings Tool Help for details on using the settings. Respectively, the settings are 
Administration—Set the Minimum Length for Locations and Administration—Set the Minimum 
Length for Subscriber-Defined Alternate Extensions. 

• You can control whether subscribers can use the Cisco Unity Assistant to view the alternate 
extensions that you specify in the Cisco Unity Administrator. To do so, see the Subscribers > Class 
of Service > Profile page. The Subscriber-Defined Alternate Extension table displays the alternate 
extensions that the subscriber adds.

• Neither the Cisco Unity Administrator nor the Cisco Unity Assistant will accept an extension that 
is already assigned to another subscriber (either as a primary or alternate extension), or to a public 
distribution list, call handler, directory handler, or interview handler. Cisco Unity verifies that each 
alternate extension is unique—up to the dialing domain level, if applicable—before allowing either 
an administrator or a subscriber to create it.

• All alternate extensions utilize the same transfer settings as the primary extension. 

• In many cases, Cisco Unity can activate a message waiting indicator (MWI) for an alternate 
extension, though depending on the phones and phone systems involved, some additional phone 
system programming may be required to set this up.

Setting Up Alternate Extensions
Do the applicable procedure to add, modify, or delete alternate extensions:

• To Add Administrator-Defined Alternate Extensions, page 34

• To Modify or Delete Alternate Extension(s), page 34
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To Add Administrator-Defined Alternate Extensions 

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

Step 2 In the Administrator-Defined Alternate Extensions table, enter an extension in any row. When entering 
characters in the Alternate Extensions table, consider the following:

• You can enter an extension up to 30 characters in length. (SIP integrations can use up to 30 
alphanumeric characters.)

• Each extension must be unique—up to the dialing domain level, if applicable. 

• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• For SIP integrations, you can also enter a valid alias for a SIP URL. For example, if the URL is 
SIP:aabade@cisco.com, enter aabade. Do not use spaces.

• Rows are numbered as a convenience. You can enter alternate extensions in any order, and you can 
have blank rows.

Step 3 Repeat Step 2 as necessary.

Step 4 Click the Save icon. Alternate extensions are enabled for all rows in the table.

Note You can run the Cisco Unity Bulk Import wizard when you want to add alternate extensions for multiple 
subscribers at once. When you do, the Cisco Unity Bulk Import wizard appends the existing table of 
alternate extensions, beginning with the first blank row.

To Modify or Delete Alternate Extension(s)

Step 1 In the Cisco Unity Administrator, go to any Subscribers > Alternate Extensions page.

Step 2 Do any of the following:

• To modify an extension, change the extension in the Alternate Extensions table.

• To delete extensions, check the check boxes next to the alternate extensions that you want to delete.

• To remove all alternate extensions listed in the table, click Select All.

Step 3 Click the Save icon.

Step 4 Repeat Step 2 and Step 3 as necessary.

Alternate MWIs
You can set up Cisco Unity to activate alternate MWIs when you want a new message for a subscriber 
to activate the MWIs at up to 10 extensions. For example, a message left at extension 1001 can activate 
the MWIs on extensions 1001 and 1002.

Cisco Unity uses MWIs to alert the subscriber to new voice messages. MWIs are not used to indicate 
new e-mail, fax, or return receipt messages.
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In Cisco CallManager integrations, you can also use the alternate MWI feature to activate MWIs on a 
non-integrated phone system that can send and receive information from Cisco Unity over an RS-232 
serial cable.

This section contains the following information:

• Setting Up Alternate MWIs for Extensions on the Same Phone System, page 35

• MWIs for Extensions on a Non-Integrated Phone System, page 36

• Setting Up MWIs for Extensions on a Non-Integrated Phone System, page 37

Setting Up Alternate MWIs for Extensions on the Same Phone System
Cisco Unity can activate alternate MWIs for extensions on the same phone system. Note that depending 
on the phones and phone systems, some additional phone system programming may be necessary. Refer 
to the installation guide for the phone system.

To enable alternate MWIs for extensions on the same phone system, do the following procedure for each 
subscriber who needs alternate MWIs.

To Set Up Alternate MWIs for Extensions on the Same Phone System

Step 1 In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > Messages page.

Step 2 Confirm that the Use MWI for Message Notification check box is checked.

Step 3 Click the Add button located beneath the MWI Extensions table to add a row to the table. By default, 
the first row in the table contains an “X” to indicate the primary extension assigned to a subscriber. If 
you want one more extension and do not need to activate the MWI on the primary extension, you can 
also modify the first row.

Step 4 Enter the applicable extension in the Extension field of the table. MWIs are automatically enabled for 
all rows in the table. When entering characters in the MWI Extensions table, consider the following:

• Enter digits 0 through 9. Do not use spaces, dashes, or parentheses.

• Enter , (comma) to insert a one-second pause.

• Enter # and * to correspond to the # and * keys on the phone.

Step 5 Click the Save icon.

Step 6 Repeat Step 3 through Step 5 as necessary.

Note You can run the Cisco Unity Bulk Import wizard when you want to set up alternate MWIs for multiple 
subscribers at once.

To change or delete alternate MWIs for extensions, do the following procedure.

To Modify or Delete Alternate MWIs

Step 1 In the Cisco Unity Administrator, go to the applicable Subscribers > Subscribers > Messages page.

Step 2 Do either of the following:
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• To modify an extension, change the extension in the MWI Extensions table.

• To delete extensions, check the check boxes next to the rows that you want to delete in the MWI 
Extensions table, and then click the Delete button.

Step 3 Click the Save icon.

Step 4 Repeat Step 2 and Step 3 as necessary.

MWIs for Extensions on a Non-Integrated Phone System
Cisco Unity can activate MWIs on a phone system that is not integrated with Cisco Unity and that is not 
part of a dual phone system integration (referred to here as a non-integrated phone system). MWI 
activation requests are sent through an RS-232 serial cable.

For this method, you must set up:

• A trunk connection between Cisco CallManager and the non-integrated phone system through a 
gateway.

• The unique subscriber extensions on the non-integrated phone system to forward on no answer to 
the corresponding phantom extensions on Cisco CallManager.

• The Switch.ini file (phone system configuration file) to enable Cisco Unity access through the serial 
cable for turning alternate MWIs on and off.

• An RS-232 serial cable between a Cisco Unity serial port and the non-integrated phone system serial 
port to send alternate MWI activation requests.

• The Cisco Unity serial configuration file, if the non-integrated phone system uses a serial 
configuration different from the default serial configuration used by Cisco Unity.

Figure 6 shows the connections via a serial cable between a Cisco CallManager integration and a 
non-integrated phone system.

Figure 6 Connection for Sending Alternate MWIs via a Serial Cable to a Non-Integrated Phone 

System from a Cisco CallManager Integration

Calls to subscribers that come from the non-integrated phone system are routed through the gateway to 
Cisco CallManager.
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Setting Up MWIs for Extensions on a Non-Integrated Phone System
To set up MWIs for extensions on a non-integrated phone system, do the following applicable 
procedures.

To Set Up MWIs on a Non-Integrated Phone System

Step 1 Set up a trunk connection between the non-integrated phone system and Cisco CallManager through the 
gateway.

Step 2 In the Cisco Unity Administrator, set up the subscriber for the phantom extension, making use of the 
subscriber information from the corresponding extension on the non-integrated phone system, including 
the following settings:

• On the Subscriber > Profile page for the subscriber, in the Extension field, enter the corresponding 
extension on the non-integrated phone system.

• On the Subscriber > Call Transfer page for the subscriber, under Transfer Incoming Calls, click No.

• On the Subscriber > Messages page for the subscriber, confirm that the Use MWI for Message 
Notification check box is checked.

• On the Subscriber > Messages page for the subscriber, under MWI Extensions, delete the “X” and 
enter ZX.

Step 3 In the Cisco Unity Administrator, click the Save icon.

To Revise the Switch.ini File

Step 1 On the Windows Start menu, click Programs > Cisco Unity > Manage Integrations. UTIM appears.

Step 2 In the left pane of the UTIM window, click the Cisco CallManager integration, and click the Properties 
node. The Properties tab appears in the right pane of the UTIM window.

Step 3 Note the name of the Switch.ini file that appears in the Configuration File field.

Step 4 Exit UTIM.

Step 5 On the Windows Start menu, click Programs > Accessories > Notepad. The Notepad window appears.

Step 6 On the File menu, click Open.

Step 7 In the Open window, navigate to the CommServer\IntLib directory, and double-click the name of the 
Switch.ini file you noted in Step 3.

Step 8 Add a new section at the end of the file to contain the following lines. For detailed information about the 
settings, see Table 18.

[Alternate MWI]
Active=Yes
Digit=Z
MWIType=Serial
SerialConfiguration=<if applicable, the type of serial configuration for the connection>
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Step 9 Save the file, and exit Notepad.

Do the following procedure if the serial configuration used by the non-integrated phone system is 
different from the default serial configuration that Cisco Unity uses.

To Revise the Cisco Unity Serial Configuration File

Step 1 On the Windows Start menu, click Programs > Accessories > Notepad. The Notepad window appears.

Step 2 On the File menu, click Open.

Step 3 In the Open window, navigate to the CommServer\IntLib directory, and double-click the file 
corresponding to the serial configuration you are using to activate alternate MWIs:

• Avsmdi.avd

• Avmci.avd

• Avinte.avd

• Averic.avd

Step 4 Under the [Configuration] divider, revise the settings to match the configuration required by the 
non-integrated phone system. Refer to the phone system and its documentation for this information.

Step 5 Save the file, and exit Notepad.

Table 18 Alternate MWI Settings in the Switch.ini File

Line Setting

Active Enter Yes to enable alternate MWIs or No to disable alternate MWIs.

Digit Enter Z to represent the LampOn and LampOff digits in the MWI Extensions 
field on the Subscriber > Subscriber > Messages page.

MWIType Enter Serial.

SerialConfiguration If the MWIType field is Serial, enter the type of serial configuration:

• SMDI (for most serial connections)

• MCI (only for NEC NEAX phone systems)

• Inte (only for Intecom E14 Millennium phone systems)

• Eric (only for Ericsson MD-110 phone systems)
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Appendix: Documentation and Technical 
Assistance

Conventions
The Cisco CallManager 3.2 Integration Guide for Cisco Unity 4.0 uses the following conventions.

The Cisco CallManager 3.2 Integration Guide for Cisco Unity 4.0 also uses the following conventions:

Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, you might do something that could result in equipment 
damage or loss of data.

Table 19 Cisco CallManager 3.2 Integration Guide for Cisco Unity 4.0 Conventions

Convention Description

boldfaced text Boldfaced text is used for:

• Key and button names. (Example: Click OK.)

• Information that you enter. (Example: Enter Administrator in the User 
Name box.)

< > 

(angle brackets)

Angle brackets are used around parameters for which you supply a value. 
(Example: In the Command Prompt window, enter ping <IP address>.)

- 

(hyphen)

Hyphens separate keys that must be pressed simultaneously. (Example: Press 
Ctrl-Alt-Delete.)

> 

(right angle 
bracket)

A right angle bracket is used to separate selections that you make:

• On menus. (Example: On the Windows Start menu, click Settings > Control 
Panel > Phone and Modem Options.)

• In the navigation bar of the Cisco Unity Administrator. (Example: Go to the 
System > Configuration > Settings page.)

[x]

(square brackets)

Square brackets enclose an optional element (keyword or argument). (Example: 
[reg-e164])

[x | y]

(vertical line)

Square brackets enclosing keywords or arguments separated by a vertical line 
indicate an optional choice. (Example: [transport tcp | transport udp])
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Cisco Unity Documentation
For descriptions and URLs of Cisco Unity documentation on Cisco.com, refer to About Cisco Unity 
Documentation. The document is shipped with Cisco Unity and is available at 
http://www.cisco.com/univercd/cc/td/doc/product/voice/c_unity/about/aboutdoc.htm.

Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco websites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 800 553-NETS (6387).

Documentation Feedback
You can submit e-mail comments about technical documentation to bug-doc@cisco.com.
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Obtaining Technical Assistance
You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, the Cisco 
Technical Assistance Center (TAC) provides 24-hour-a-day, award-winning technical support services, 
online and over the phone. Cisco.com features the Cisco Technical Support website as an online starting 
point for technical assistance. If you do not hold a valid Cisco service contract, please contact your 
reseller.

Cisco Technical Support Website
The Cisco Technical Support website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The Cisco Technical Support website 
is available 24 hours a day, 365 days a year. The Cisco Technical Support website is located at this URL:

http://www.cisco.com/tac

Accessing all the tools on the Cisco Technical Support website requires a Cisco.com user ID and 
password. If you have a valid service contract but do not have a login ID or password, register at this 
URL: 

http://tools.cisco.com/RPF/register/register.do

Opening a TAC Case
Using the online TAC Case Open Tool is the fastest way to open P3 and P4 cases. (P3 and P4 cases are 
those in which your network is minimally impaired or for which you require product information.) After 
you describe your situation, the TAC Case Open Tool automatically recommends resources for an 
immediate solution. If your issue is not resolved using the recommended resources, your case will be 
assigned to a Cisco TAC engineer. The online TAC Case Open Tool is located at this URL:

http://www.cisco.com/tac/caseopen

For P1 or P2 cases (P1 and P2 cases are those in which your production network is down or severely 
degraded) or if you do not have Internet access, contact Cisco TAC by telephone. Cisco TAC engineers 
are assigned immediately to P1 and P2 cases to help keep your business operations running smoothly.

To open a case by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227) 
EMEA: +32 2 704 55 55 
USA: 1 800 553-2447

For a complete listing of Cisco TAC contacts, go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml
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TAC Case Priority Definitions
To ensure that all cases are reported in a standard format, Cisco has established case priority definitions.

Priority 1 (P1)—Your network is “down” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Priority 2 (P2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Priority 3 (P3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Priority 4 (P4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Go 
to this URL to visit the company store:

http://www.cisco.com/go/marketplace/

• The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press online at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco quarterly publication that provides the latest networking trends, 
technology breakthroughs, and Cisco products and solutions to help industry professionals get the 
most from their networking investment. Included are networking deployment and troubleshooting 
tips, configuration examples, customer case studies, tutorials and training, certification information, 
and links to numerous in-depth online resources. You can access Packet magazine at this URL:

http://www.cisco.com/packet

• iQ Magazine is the Cisco bimonthly publication that delivers the latest information about Internet 
business strategies for executives. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj
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• Training—Cisco offers world-class networking training. Current offerings in network training are 
listed at this URL:

http://www.cisco.com/en/US/learning/index.html

Copyright © 2004 Cisco Systems, Inc. All rights reserved.
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